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This document describes compatibility issues with previous releases, software installation 
instructions, hardware and software requirements, and summary information on system and 
memory requirements. This document also lists hardware and software limitations.
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Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.
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If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is 
especially important to check each step of your workflow.

2. Check this ReadMe file for the latest information that might have become available after the 
documentation was published. Also check online for the most up-to-date ReadMe because 
the online version is updated whenever new information becomes available. To view the 
online ReadMe, select ReadMe from the Help menu, or visit the Knowledge Base at 
http://www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues. In addition to the printed documentation supplied 
with your editing application, the documentation is supplied in PDF format when you install 
the application. Topics that you print from the Help have limited page layout and formatting 
features. If you want to print a higher quality version of Help information, Avid recommends 

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in this document or on the unit itself when 
handling electrical equipment.

> This symbol indicates menu commands (and subcommands) in the 
order you select them. For example, File > Import means to open the 
File menu and then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

(Windows), (Windows 
only), (Macintosh), or 
(Macintosh only)

This text indicates that the information applies only to the specified 
operating system, either Windows or Macintosh OS X.

Bold font Bold font is primarily used in task instructions to identify user interface 
items and keyboard sequences.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the 
mouse action. For example, Command+Option+C or Ctrl+drag.

Symbol or Convention Meaning or Action

http://www.avid.com/readme
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that you print all or part of the PDF version of the appropriate Avid manual included in the 
Online Library for your editing application. To access the Online Library, select Help > 
Online Library from within your Avid editing application. 

4. Visit Avid Online Support at www.avid.com/onlineSupport/. Online support is available 24 
hours per day, 7 days per week. Search the Knowledge Base to find answers, to view error 
messages, to access troubleshooting tips, to download updates, and to read or join online 
message-board discussions.

Changes in Media Composer v6.5.2, Symphony 
v6.5.2, and NewsCutter v10.5.2

The following changes have been included with this release of the editing application.

Interplay Sphere Support on Macintosh Systems

Interplay Sphere allows you to edit media either stored locally on your system or stored on an 
Interplay server back at your production facility or broadcast station. If your Avid NewsCutter, 
Media Composer, or Symphony application runs on a Windows system, you can quickly upload 
your content from the field using a Wi-Fi or wireless connection and check it in to Interplay as 
you work. 

With this release of Media Composer and Symphony, these editing systems on the Macintosh 
platform support edit and playback media that is either local or remote on Interplay Sphere. 
Remote upload and remote Interplay check-in are not currently supported on Macintosh systems. 
See Interplay Sphere documentation here for more information.

Set Source Settings

The editing application allows you to select Set Source Settings for media that is created with 
codecs that are not natively supported, for example, H.264, RED. If your media was created with 
a codec that is supported natively, Set Source Settings will not be available. If you try to select 
Set Source Settings for a natively supported codec, you will receive a “Selected clip cannot 
accept source settings” message.

In previous releases you were able to select Set Source Settings for ProRes QuickTime. With this 
release, ProRes Quicktime has been promoted to a native codec for increased performance and 
the ability to consolidate files. As a result, Set Source Settings is not available for ProRes 
QuickTime at this time.

http://www.avid.com/onlinesupport
http://avid.force.com/pkb/articles/en_US/user_guide/Avid-Interplay-Sphere-Documentation
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Excluding Filler when Selecting Multiple Segments

With this release, you can use a modifier key to exclude filler when selecting multiple segments. 

To select segments on enabled tracks using the multiple segment selection buttons:

1. Move the position indicator to the first or last segment you want to select.

2. Select Tools > Command Palette, and click the Edit tab.

3. Do one of the following:

t Click the Select Left button to select segments under the position bar and all segments to 
the left.

t Click the Select Right button to select segments under the position bar and all segments 
to the right.

t Click the Select In/Out button to select segments intersecting In and Out marks if both 
marks are present.

If the Timeline has only an In mark or an Out mark, or no In and Out marks, the Select 
In/Out button selects all segments under the position bar.

Holding the Alt key (Windows) or Option key (Macintosh) while selecting the Select Left, Select 
Right, or Select In/Out button will exclude filler from the selection.

Sequential Files Marker Export Update

(UDevC00174545) Additional options have been added to the Settings when Exporting as a 
Graphic. When you select the Sequential Files option in the Export as Graphic setting, your Avid 
editing application produces a series of still images, numbered in sequential timecode order.

When you select Markers Only, images are produced only for those frames that contain markers. 

Two additional options have been added to the Sequential Files option when Markers Only is 
selected.
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• Topmost Image: When this option is selected, if you have multiple tracks, and a marker is on 
a lower track but is obscured by a higher track clip, the highest available track will be used in 
the sequential list over the lower track.

• Use Comments: When this option is selected, the marker comment will be used as the name 
for the saved graphic.

Fixed in Media Composer v6.5.2, Symphony v6.5.2, 
and NewsCutter v10.5.2

The following have been fixed:

➤ Bug Number: UDevC00175400.  Renaming the video display settings no longer results in a Bus 
error or crash.

➤ Bug Number: UDevC00171715. (NewsCutter) Default Edit Workspace now appears correctly.

When adding the Keyboard Setting to Site Settings, if you have any Keyboard Workspace 
mappings, please also add the Workspace Linking settings to Site Settings as well.

➤ Bug Number: UDevC00173402.  You might have received Decomp stream errors when 
importing XDCAM MXF files from Digital Rapids transcodes. 
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➤ Bug Number: UDevC00174526.  The Send To DVD menu options appear as Send To Disc. 

➤ Bug Number: UDevC00172432.  Previously, clicking to enable/disable Volume Mounting 
options in the AMA settings sometimes enabled/disabled the option above or below.

➤ Bug Number: UDevC00173290.  When exporting a newly exported AAF sequence, 
Exported.xx did not get added to the name of the exported sequence. 

➤ Bug Number: UDevC00172041.  (AS02) (Macintosh) Creating a new Volume Directory no 
longer defaults to the previously created volume.

➤ Bug Number: UDevC00171941.  (AMA) Linking to an XDCAM clip on a mountable drive at 
the same level of a CONTENTS folder, resulted in a “a media directory” error.

➤ Bug Number: UDevC00173117. (AS02) The Default shim name is now displayed properly.

➤ Bug Number: UDevC00172320.  The process of SDI capture followed by SDI digital cut would 
slip the A/V sync by a couple of scan lines, so that after multiple round trips the video frame 
edge was no longer aligned with the Dolby E safe edit region. Once slipped far enough, edits 
would corrupt the Dolby-E data stream. This problem has been corrected so that no A/V sync 
slip occurs between capture and digital cut over SDI. 

➤ Bug Number: UDevC00172913. After transcoding certain AMA-linked QuickTime movie clips 
to Avid Packed (1:1 10bit) in interlaced SD projects, some frames might have contained artifacts.

➤ Bug Number: UDevC00172549.  (Macintosh) Performing a Send to Playback in AirSpeed 5000 
Team Mode, with a sequence containing an XDCAM clip might have resulted in an Assertion 
error. 

➤ Bug Number: UDevC00169966. If you loaded a clip in the Source monitor and a sequence in 
the Record monitor, and then clicked the Toggle Source/Record button in the Timeline, the Start 
Remote Sync Sequence button in the Timeline became inactive.

➤ Bug Number: UDevC00170350. The Remote Upload Settings menu includes VC1 APL3 MXF 
in list of resolution options, although this resolution is not supported for Interplay transcode. 
This has been fixed, and the resolution no longer appears in the upload settings.

➤ Bug Number: UDevC00169956. If you remotely uploaded a sequence in the Timeline, loaded 
another sequence in the Timeline that you did not upload, then reloaded the first sequence, the 
Start Remote Sync Sequence button did not change to the Stop Remote Sync Sequence button 
and was not highlighted even though the sequence in the Timeline was still uploading to or 
syncing with Interplay. 
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➤ Bug Number: UDevC00173572, UDevC00172691. Trying to remotely play precomputes 
resulted in purple frames displaying in the monitor. Similarly, some offline clips also might have 
displayed as purple frames. In remote playback, You cannot remotely play back precomputes or 
other unrendered media. Offline clips now correctly display as offline media.

➤ Bug Number: UDevC00172051. If you attempted to remotely upload an AMA file that had 
been linked to P2 media, the upload failed, while uploading an AMA volume linked P2 media 
succeeded. This has been fixed and both upload workflows work.

➤ Bug Number: UDevC00144458.  You could not promote a 2D effect to a 3D effect after 
performing an AAF export/import or an Interplay checkin/checkout. 

➤ Bug Number: UDevC00174276.  The J2K resolution was not filtered out if you added it to the 
DisabledRes.txt file.

➤ Bug Number: UDevC00174522.  Media Creation settings were not retained if you switched 
Formats, Raster, ColorSpace or Stereoscopic mode.

➤ Bug Number: UDevC00174151.  Bins were unnecessarily saving when closing, even when no 
changes had been made to their contents. 

➤ Bug Number: UDevC00173731.  If you toggled the hardware I/O button in the Timeline and 
then switched to at 24p project, you received an “Internal reference audio clock source has a 
problem” error.

➤ Bug Number: UDevC00173358.  If you interrupted the drawing of the audio waveform when 
performing something such as a playback operation, the waveform did not redraw once play 
stopped.

➤ Bug Number: UDevC00174697. When relinking based on bin columns, a relink might have 
failed if you were relinking by Name and selected “Ignore characters after the last occurrence” 
and the ignored character appeared twice in the name.

➤ Bug Number: UDevC00172041. When creating an AS02 volume in a project, the path for the 
volume might have defaulted to the previously created volume.

➤ Bug Number: UDevC00173164. When refreshing AMA linked QuickTime clips on ISIS 
mounted workspaces, the bins would flash in random locations on screen as each clip was 
relinked.

➤ Bug Number: UDevC00173067. If the Video Quality playback option was set to 10-bit in the 
Timeline, an effect overlay would blank out the client monitor.
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➤ Bug Number: UDevC00171968. Pressing Shift + F2 now cycles through sub tabs for Master, 
Highlights, Midtones, and Shadows when working with the Avid Artist Color.

➤ Bug Number: UDevC00173118. The Marquee Title Tool generated illegal YCbCr black and 
white.

➤ Bug Number: UDevC00173432. (Windows and Nitris DX) The editing application was 
sluggish when scrubbing in the Timeline while in Color Correction mode with Video Track 
Monitoring off. 

➤ Bug Number: UDevC00173291. (Windows and Nitris DX) The editing application was 
sluggish when scrubbing in the Timeline while in Color Correction mode.

➤ Bug Number: UDevC00175008. If you had performed an Upgrade or Repair of an earlier 
version of the editing application, the Color Correction vectorscope tools did not display 
properly. Uninstalling the earlier version and installing v6.5.2 will fix this. 

➤ Bug Number: UDevC00173327. When pasting many tracking points, you might have received 
an “Assertion failed” error.

➤ Bug Number: UDevC00165724. At the end of a digital cut, you could not enter a value in the 
“Add black” option in the Digital Cut tool. 

➤ Bug Number: UDevC00174594. With Offline selected in the Clip Color dialog, certain video 
formats did not color correctly in the Timeline.

➤ Bug Number: UDevC00175083. When you single clicked on a clip in Text view, the clip names 
flashed. 

➤ Bug Number: UDevC00173403. Markers added to the first frame of a sequence did not appear 
in the Timeline. 

➤ Bug Number: UDevC00174466. If a project or bin name contained certain Japanese characters, 
trying to save would result in an error.

➤ Bug Number: UDevC00175034. Occasionally, changing the bin to Frame View when it 
contained a sequence with a Fluid Blur effect resulted in an “Assertion failed” error. 

➤ Bug Number: UDevC00172116. You might have received “SMRETURN TAPEMOB” errors 
when modifying the tape name of Canon media.

➤ Bug Number: UDevC00173298. An exported ALE would display 30fps timecode for 720p 
59.94 clips.
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➤ Bug Number: UDevC00175074. Saving bins containing master clips generated with Open 
Cube might have been extremely slow. Multiple “Warning: the path conversion” errors appeared 
in the Console window. 

➤ Bug Number: UDevC00173030. Avid Artist Transport did not respond if you were in Audio 
Loop play mode.

➤ Bug Number: UDevC00173682. If audio was set to 96kHz, audio playback speed doubled if 
you switched from hardware mode to software mode.

➤ Bug Number: UDevC00175144. You could not right click an audio keyframe to access the 
keyframe menu with grouped clips.

➤ Bug Number: UDevC00152550. Extending the length of a clip with a rendered Audio EQ effect 
did not retain any previous changes made with the Audio Mixer tool.

➤ Bug Number: UDevC00174846. When using the keyboard number pad to enter numbers in the 
Trim counter under the Source/Record monitor, the numbers were unreadable.

➤ Bug Number: UDevC00173488. You were able to add clips to AS02 volumes by duplicating 
the clip. This has been fixed to allow you to only add sequences to volumes.

➤ Bug Number: UDevC00173123. The AMA File Export menu was placed below the Open Bin 
option in the File menu. It now is above the Export option in the File menu.

➤ Bug Number: UDevC00172629. Selecting Set Shim Name did not display the correct shim 
path.

➤ Bug Number: UDevC00172571.  Reopening a project in a custom workspace did not open with 
the correctly sized video monitor.

➤ Bug Number: UDevC00172677.  Loading two AS02 committed sequences to a popup monitor 
might have resulted in an error or crash. 

➤ Bug Number: UDevC00173188.  AS02 volume source clips appeared in the bin with a yellow 
status. They now correctly appear with green status.

➤ Bug Number: UDevC00174238.  (Macintosh) If you changed the path of a committed volume, 
the application might have quit unexpectedly.

➤ Bug Number: UDevC00173892.  Trim rollers disappeared and the Source/Record monitor 
appeared black after undoing a trim in Trim mode.
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➤ Bug Number: UDevC00166334.  (NewsCutter) Formatting buttons such as Bold, Italic, 
Underline, Closed Captioning, etc, now work properly in the NRCS Tool.

➤ Bug Number: UDevC00174607.  You received an error message if you tried to save a bin that 
contained more than 32766 objects. Now when you try to save a bin with too many objects, you 
will receive a dialog that indicates the bin has too many objects. You can choose to save the bin 
in a format that cannot be opened in versions of the editor prior to NewsCutter 10.5.2, Media 
Composer 6.5.2 or Symphony 6.5.2. Or you can Cancel and divide the bin objects into multiple 
bins and then save them if it is necessary to open them in previous versions.

➤ Bug Number: UDevC00167479.  (Avid Artist Color) Selecting Shift+F2 soft key will cycle 
through the HSL sub tabs (Master, Highlights, Shadows, Midtones).

➤ Bug Number: UDevC00173157.  If you enabled tracks in the Capture tool then clicked on your 
desktop, the tracks were not enabled when you returned to the Capture tool.

➤ Bug Number: UDevC00174189. The clip duration might not have been correct when importing 
a partial XDCAM HD clip that was generated with Front Porch Digital. A fix has been made to 
the editing application and the AMA MXF Plug-in to fix this issue. Make sure you install AMA 
MXF v1.4.1 Plug-in. See www.avid.com/ama for information on AMA Plug-in downloads.

➤ Bug Number: UDevC00173975. You can now enable Loop Play by selecting Alt+6.

➤ Bug Number: UDevC00174696. When in Frame View, changing the clip name font size might 
have resulted in clips being reordered in the bin.

➤ Bug Number: UDevC00173911. When in Frame View, if you selected all clips in the bin, the 
clip names flashed until all clips were selected.

➤ Bug Number: UDevC00173549. (NewsCutter) Some Arabic text in the NRCS Tool would 
cause the editing application to hang.

➤ Bug Number: UDevC00174114. (NewsCutter) Text appeared to shrink when editing text in the 
NRCS Tool.

➤ Bug Number: UDevC00173560. Improvements have been made to the performance of the 
Region Stabilizer effect.

➤ Bug Number: UDevC00172204. When using a French keyboard, using the Quick Transition 
shortcut caused the Timecode numeric entry box to appear in the Record monitor.

http://www.avid.com/US/products/Avid-Media-Access/Plug-ins
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➤ Bug Number: UDevC00171879.  If a sequence or clip name was too long to appear in the 
Source or Record window, it appeared with an ellipsis (...). The previous release added a random 
character instead of the ellipsis. The long name now displays with the ellipsis.

➤ Bug Number: UDevC00174262.  Permanent locked files were removed when a bin was closed.

➤ Bug Number: UDevC00172982. With a German or French keyboard, some special characters 
such as @ were not working properly. 

➤ Bug Number: UDevC00174277.  Ctrl+Alt+E (Windows) and Command+Option+E 
(Macintosh) did not allow reverse sort in bins.

➤ Bug Number: UDevC00170550.  You might not have been able to map anything to mouse 
buttons.

➤ Bug Number: UDevC00172379.  The source subclip color did not show in the Timeline if 
Offline was selected in the Clip Color dialog.

➤ Bug Number: UDevC00174341.  If you changed the Timeline view after lassoing clips, the 
lassoed clips no longer appeared highlighted.

➤ Bug Number: UDevC00173576.  If you received an “Insufficient Source Material” error 
message when overwriting a clip in the Timeline, a subsequent Audio only overwrite or replace 
edit might have occurred at incorrect locations.

➤ Bug Number: UDevC00174270.  Mouse wheel stepping did not work properly.

➤ Bug Number: UDevC00174178.  You could not return to the default workspace layout after 
restoring the default and then toggling between workspaces.

➤ Bug Number: UDevC00169012.  Duplicate stereo tracks were created if you chose to split a 
stereo master clip to mono. The “split to mono” option should only have been available when 
selecting a sequence.

➤ Bug Number: UDevC00172814. (Macintosh) After creating a title, performing a Fast Save and 
then choosing to Create Unrendered Title Media, the name of the title in the bin appeared 
truncated.

➤ Bug Number: UDevC00174309. If you had multiple lines in the comments of a Marker, 
selecting Shift+Return did not move you up the line as it did in previous releases.

➤ Bug Number: UDevC00174321. The cursor did not appear in the Marker comment field 
making it difficult to see where you were typing.
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➤ Bug Number: UDevC00174384. You could not select all the text in a Marker window by double 
clicking or by selecting Command+A.

➤ Bug Number: UDevC00174310. Performing a copy/paste from a Bin column to a Marker 
window did not clear out the existing text when pasting.

➤ Bug Number: UDevC00169387. You might have seen performance regression when using the 
Stabilize effect.

➤ Bug Number: UDevC00172341.  Comments added to a group clip were lost once you 
committed the Multicam edits. 

➤ Bug Number: UDevC00172850. You could not resize the Timecode window if there were 27 or 
more tracks in the sequence.

➤ Bug Number: UDevC00169616. (FilmScribe) Tabbed lists did not display correctly in Preview 
or Text mode.

➤ Bug Number: UDevC00169554. (FilmScribe) Scan lists did not preview or save as tab 
delimited.

➤ Bug Number: UDevC00166453. (FilmScribe) An XML list did not display properly in a 
browser.

➤ Bug Number: UDevC00172687. Corner pin keyframes were not displayed and created correctly 
when cropping was enabled.

➤ Bug Number: UDevC00173060. With European keyboards, users could accidentally delete 
projects from the startup window by accidentally pressing Delete and Enter. The default has been 
changed from OK to Cancel to prevent this.

➤ Bug Number: UDevC00172968. Regaining mouse control was slow after dragging and 
dropping an audio clip from the bin to the Source Monitor. 

➤ Bug Number: UDevC00172230. The Import setting for Broadcast Wave Groups was not visible 
in the Japanese OS. 

➤ Bug Number: UDevC00172885. With a long XDCAM clip, you might have received Access 
violations when consolidating subclips. 

➤ Bug Number: UDevC00169708. When working with mixed rate clips, the “Use closest media” 
option was not considered, leading to unpredictable results. 
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➤ Bug Number: UDevC00171494. Story timing could differ between the NRCS tool, iNEWS and 
Instinct tools.

➤ Bug Number: UDevC00172801.  In some instances, the Source/Record monitors toggled to 
four-frame display regardless of whether or not four-frame display was enabled in Timeline 
Settings.

➤ Bug Number: UDevC00167246. The Time Compression Expansion AudioSuite plugin displays 
incorrect information. This has been fixed. Avid does recommend that you use the Time Shift 
plugin.

➤ Bug Number: UDevC00170980.  (Macintosh) Occasionally the editing application would hang 
when rebuilding databases.

➤ Bug Number: UDevC00170536.  While in an Interplay environment, opening bins with 1080p 
clips in a1080i project might have resulted in a “Segmentation fault” error.

➤ Bug Number: UDevC00171340.  A promoted Pan&Zoom effect could not import an image if 
the precompute was no longer available.

➤ Bug Number: UDevC00170125. During recording from a RME ADI 4DD converter through 
the Nitris DX ADAT input, you might have heard an audio crackle on the ADAT out of the Nitris 
DX.

➤ Bug Number: UDevC00173432.  (Nitris DX) With Video Track Monitoring Off in Color 
Correction mode, scrubbing in the Timeline was sluggish.

➤ Bug Number: UDevC00168246.  Region Stabilize Auto Zoom was not working properly.

➤ Bug Number: UDevC00172100. You could not read audio timecode from AMA linked media.

➤ Bug Number: UDevC00144458.  After performing an AAF export/import or checking in/out 
from Interplay, you could not promote 2D effects to 3D effects.

➤ Bug Number: UDevC00169672. You might have received an “Exception:pglue” error after 
rendering a Time Shift Audio Suite effect.

➤ Bug Number: UDevC00173485.  In a shared project on Interplay, if Sync lock was set to REF, 
and then the project was closed and then reopened, the Sync lock was reset to Internal.

➤ Bug Number: UDevC00171502. It took several seconds for the menu to appear when 
performing a right+click on a large ProRes file.
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➤ Bug Number: UDevC00173445. Audio only clip names might have appeared truncated in the 
Timeline.

➤ Bug Number: UDevC00173359.  (Avid Artist Color) If the Color Correction settings enabled 
10bit RGB, no cursor was displayed on the Color Correction Curves graph.

➤ Bug Number: UDevC00172154.  (NewsCutter) If Render-on-the-Fly was enabled, effects were 
not displaying properly while in Trim Mode.

➤ Bug Number: UDevC00171745. Using the ALT key as a modifier to move keyframes in the 
Timeline was not working properly.

➤ Bug Number: UDevC00173483. If you were monitoring audio input you could not play in 
Standby mode.

➤ Bug Number: UDevC00173409. After choosing to eject a tape from the Capture tool, you were 
not prompted for the next tape name.

➤ Bug Number: UDevC00173213. Dynamic Relink site settings reverted after a project with a 
different format was created.

➤ Bug Number: UDevC00173839. You might have received an access violation error after 
committing Multicam edits.

➤ Bug Number: UDevC00173393.  You could not Send To Playback an online sequence that used 
a clip that was partially offline.

➤ Bug Number: UDevC00172409. Exporting to a P2 device might have resulted in corrupt media. 

➤ Bug Number: UDevC00171444. In some instances, you could not save a bin on ISIS 5000. This 
was due to path issues. A dialog now appears if you open a project via a UNC path, prompting 
you to open the project from a mapped volume.

➤ Bug Number: UDevC00173321.  Selecting the “Levels” tab in Color Correction mode was 
taking longer than in previous releases. 

➤ Bug Number: UDevC00173561.  If you had greater than 23 tracks, audio mixdown track 
placement was inconsistent. 

➤ Bug Number: UDevC00171249.  (Avid Artist Color) Avid Artist Color performance degraded 
when waveforms were displayed.
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➤ Bug Number: UDevC00171712. Scrubbing through a sequence might have been sluggish when 
the Data Track was enabled.

➤ Bug Number: UDevC00174241. You might have experienced sync lock issues when working in 
Trim mode. 

➤ Bug Number: UDevC00169958.  (NewsCutter) When monitoring audio input there may have 
been delays at start of play.

New in Media Composer v6.5, Symphony v6.5, and 
NewsCutter v10.5

For information on new features, see the What’s New pdf. 

AMA Plug-ins

The AMA QuickTime Plug-in, AS-02 Plug-in and the MXF Plug-in are included with your Avid 
editing application. All other AMA Plug-ins are downloaded and installed separately. See 
www.avid.com/ama.

Audio Device Drivers

For a listing of currently supported Audio device drivers, see  
http://avid.force.com/pkb/articles/en_US/Download/en379411

Before Installing the Editing Application

Read through the Installation Guide for Avid Editing Applications. This document is available on 
the Knowledge Base.

n (Windows) Note for Administrators: You must give the user the right to “raise thread priority.” 
This must be done within the Domain Group Policy by giving the right explicitly to the user or 
giving the right to a group and adding the user to that group.You will not be able to launch as a 
regular user if this is not set properly.

Download Note: To avoid “File Path too long” or a “File cannot be copied” warning while 
unzipping the downloaded installer, try placing the installer .zip on the root level of your C:\ 
drive and unzip it from that location.

http://www.avid.com/US/products/Avid-Media-Access
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Notes on Macintosh OS

The Avid editing application Macintosh installer switches to 64-bit. Please make sure that your 
Macintosh system supports 64-bit prior to installing and that your current non-Avid applications 
are compatible to run in 64-bit mode.

Notes on Windows 7 OS

Note the following topics if you are running the editing application on the Windows 7 OS.

Disabling Desktop Compositing

When the Avid editor is launched you might see a dialog box asking you to disable desktop 
compositing. You can disable it without adversely affecting the Avid editing application.

You can choose to disable it and continue with your editing session. The dialog will appear once 
you relaunch the application unless you disable the option.

To disable the desktop compositing:

1. Access the Control Panel.

2. Double-click System.

3. Click Change Settings.

4. Click the Advanced tab.

5. Under the Performance area, click Settings. 

6. Uncheck “Enable desktop composition.”

The dialog box requesting you to disable desktop compositing does not appear the next time 
you launch the editing application. 

Standard User

You need to first install the editing application as an Administrator. If you are in a Shared 
Storage environment, mount your workspaces as an Administrator. You may then log off and log 
back in as a Standard user, if necessary. 
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Notes on Software Licensing

If You Upgrade Your Operating System

If you need to upgrade your operating system after you install your Avid editing application, first 
deactivate your software. After you upgrade your operating system and, if required, reinstall 
your application, you can reactivate your software. For information on activating and 
deactivating your software license, see the Installation Guide for Avid Editing Applications.

Minimum RAM Recommendation

For this release Avid recommends a minimum of 4GB of RAM. Some features might require 
more RAM and specific hardware. See “Feature Performance” on page 35 for more info.

Qualified Hardware and Operating Systems

Some features are processor-intensive and require specific hardware. See “Feature Performance” 
on page 35 for more info.

The following tables provide the information on qualified Windows and Macintosh hardware. 

For 3rd-Party Open IO hardware qualification refer to the manufacturer’s documentation. See the 
Open IO Frequently Asked Questions document on the Knowledge Base: 
http://avid.force.com/pkb/articles/en_US/faq/en422991

The following tables also list the qualified Operating Systems. Depending upon your hardware 
the qualified Operating Systems are:

• Windows 7 64-bit SP1(Professional)

• (Media Composer and Symphony) Macintosh Lion v10.7.1, v10.7.2, v10.7.3, v10.7.4, 
v10.7.5 and Mountain Lion v10.8, v10.8.1, v10.8.2

n The editing application on a system with the Mountain Lion OS is supported with local storage 
only.

http://avid.force.com/pkb/articles/en_US/faq/en422991
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Macintosh OS Permission Information

As of Macintosh OS 10.7 Lion, the default permissions for the root level of the system drive are 
now set to “Read Only” for all users. This prevents the Avid Editing Application from being able 
to use this drive as a media drive. You will see the drive grayed out in Media Creation settings or 
as an option for import, mixdown, render, and consolidate/transcode.

If you don’t intend to use the system drive for media you can leave it alone. This is ideal in most 
cases.

If you do need to use the system drive, perform the following to change permissions.

To change permissions:

1. Click on your system drive (Macintosh HD in most cases) to highlight.

2. From the File menu select Get Info (cmd+I)

3. Click the lock icon in the bottom right to make changes

4. Click on the “Read only” text in the Privilege column next to Everyone and set the privilege 
to “Read & Write”

You should now be able to see the system drive as a valid media drive.

n If you repair permissions on the system drive, they will reset and you will have to repeat this 
procedure.

Macintosh v10.8 and AVCHD

If you are working with AVCHD and have Macintosh v10.8 (Mountain Lion) OS installed in 
your system, the AVCHD folder will appear as a QuickTime icon. You can perform a Link to 
Volume the same as you did when working with Macintosh v10.7, just note that the folder 
appears as a QuickTime icon. When performing a Link to File, you must right+click the AVCHD 
QuickTime icon and select Show Package Contents. Then you can see the BDV folder. Right 
+click the BDV folder and select Show Package Contents. Then you can see the files needed to 
perform an AMA Link to File.
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Qualified PC Workstations with Avid Media Composer, Avid Symphony, 
and Avid NewsCutter

The following PC Workstations are qualified with Avid Media Composer v6 and higher, Avid 
Symphony v6 and higher and NewsCutter v10 and higher.

Qualified PC 
Hardware Graphics Card Qualified OS Supported with 

HP z820 Dual 8 Core 
Intel Xeon E5-2665 2.4 
GHz

NVIDIA Quadro 
4000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP z820 Dual 6 Core 
Intel Xeon E5-2640 2.5 
GHz

NVIDIA Quadro 
4000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Lenovo ThinkStation 
E31, "Intel Xeon 
E3-1245V2 3.40 GHz 
8 GB DDR3-1600 
RAM

NVIDIA Quadro 600 
graphics adapter or 
integrated Intel HD 
Graphics P4000

Windows 7 64-bit Software Only

HP z800 Dual 6 Core, 
2.66 GHz 

NVIDIA
Quadro 4800

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP z800 Dual Quad 
Core, 2.93 GHz or 
2.66GHz

NVIDIA
Quadro 4800

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP z400 Single 6 Core 
3.33 GHz

NVIDIA 
Quadro FX 3800
Quadro 2000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP z400 Single Quad 
Core, 3.06 GHz or 2.93 
GHz

NVIDIA
Quadro FX 3800
Quadro 2000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP z210 Quad Core 
Xeon 3.3- E3-1240, 3.4 
E3-1270, 3.5 E3-1280

Quadro 600 Windows 7 64-bit Software Only

HP z200 Intel® Core™ 
i5-660 3.33 4MB/1333 
Dual-Core

NVIDIA 
Quadro 600

Windows 7 64-bit Software Only
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Qualified PC Notebooks for Avid Media Composer, Avid Symphony, and 
Avid NewsCutter

The following PC Notebooks are qualified with Avid Media Composer v6 and higher, Avid 
Symphony v6 and higher and Avid NewsCutter v10 and higher. The following applies to the 
editing system when running on a laptop:

• DNxHD capture is only supported on Mojo DX on a Quad core system with hyperthreading 
enabled. Nitris DX is not supported on laptops.

• Capture of 10 bit video for example, DNxHD 185x, is not supported on Mojo DX.

• Playback in full quality 10 bit mode is not supported

Dell™ T5500 Dual 6 
Core, 2.66GHz

NVIDIA
Quadro FX 4800
Quadro 4000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Dell T5500 Dual, 
2.93GHz Quad Core

NVIDIA 
Quadro FX 4800 
Quadro 4000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Dell T3500 Single 6 
Core, 3.2GHz 

NVIDIA 
Quadro FX 3800
Quadro 2000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Dell T3500 Single 
Quad Core, 2.93GHz 

NVIDIA
Quadro FX 3800 
Quadro 2000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP xw8600 Dual Quad 
Core, 3.0 GHz

NVIDIA 
Quadro FX 3700 

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Dell T5400 Dual Quad 
Core, 2.5 GHz or 3.15 
GHz

NVIDIA 
Quadro 3700

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP xw4600 Core 2 
Duo, 3.0 GHz 

NVIDIA
Quadro FX 570

Windows 7 64-bit Software Only
Mojo DX (No HD capture)

Dell T3400 Core 2 Duo, 
2.33GHz,or 2.66 GHz 

NVIDIA
Quadro FX 570

Windows 7 64-bit Software Only
Mojo DX (No HD capture)

Qualified PC 
Hardware Graphics Card Qualified OS Supported with 
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Qualified PC 
Notebooks Graphics Cards Qualified OS Supported With

Lenovo ThinkPad W530
"Intel Core i7-3720QM 2.6 
GHz, i7-2820QM 2.7Ghz, 
i7-3920XM 2.9GHz 

"NVIDIA Quadro 
K1000M or 
K2000M 

Windows 7 64-bit Software Only

HP 8760w i7-282Q, 
i7-2820Q 2.2 or 2.3 GHz

NVIDIA
Quadro 3000M
Quadro 4000M

Windows 7 64-bit Software Only
Mojo DX

HP 8560w, i7-2720Q, 
2820Q, 2.2 or 2.3 GHz
17” 1920 x1080

NVIDIA
Quadro 1000M
Quadro 2000M

Windows 7 64-bit Software Only

Dell M6600, i7-2720Q, 
2820Q, 2.2 or 2.3 GHz
17” 1920 x1080

NVIDIA
Quadro 3000M
Quadro 4000M

Windows 7 64-bit Software Only
Mojo DX

Dell 4600, i7-2720Q, 2820Q, 
2.2 or 2.3 GHz
15” 1920 x1080

NVIDIA
Quadro 1000M
Quadro 2000M

Windows 7 64-bit Software Only
Mojo DX

HP 8740w X820, X920 
Quad i7 (1.73, 2.0 GHz)

17" 1920x1200

NVIDIA FX
2800M

NVIDIA FX
3800M

Windows 7 64-bit Software Only
Mojo DX

HP 8540w X720, X820 
Quad i7 (1.6, 1.73 GHz)

15" 1920x1080

NVIDIA FX
1800M

Windows 7 64-bit Software Only
Mojo DX

Dell M6500 i- 820Q, 
i7-840Q, i7-920X(1.73, 1.87, 
2.0 GHz)

17" 1920x1200

NVIDIA FX
2800M

NVIDIA FX
3800M

Windows 7 64-bit Software Only
Mojo DX

HP 8730 2.53 or 3.06 GHz 
Core 2 Duo

NVIDIA
Quadro FX 2700M
Quadro FX 3700M

Windows 7 64-bit Software Only
Mojo DX (No HD capture)

HP 8530 2.53 or 3.06 GHz 
Core 2 Duo

NVIDIA
Quadro FX 770M

Windows 7 64-bit Software Only
Mojo DX (No HD capture)
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Qualified Macintosh Workstations for Avid Media Composer and Avid 
Symphony

The following Macintosh Workstations are qualified with the Avid Media Composer v6 and Avid 
Symphony v6 and higher. Mac Pro systems ship with the 64-bit kernel enabled. In previous 
releases, you had to toggle to the 32-bit kernel. With v6 and higher, you must run with the 64-bit 
enabled.

Dell 6400 2.53 or 3.06 GHz 
Core 2 Duo

NVIDIA
Quadro FX 2700M
Quadro FX 3700M

Windows 7 64-bit Software Only
Mojo DX (No HD capture)

Qualified PC 
Notebooks Graphics Cards Qualified OS Supported With

Qualified Macintosh 
Hardware Graphics Cards Qualified OS Supported With

Mac Pro “Westmere” 
Two 2.66GHz 6-Core 
Intel Xeon (12 cores) 

ATI Radeon HD 5770 Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, v10.7.5 
and Mountain Lion 
v10.8, v10.8.1, 
v10.8.2

Software Only
Nitris DX
Mojo DX

Mac Pro “Nehalem” 
2.66 GHz or 2.93 GHz 
Dual Quad Core Intel 
Xeon 

NVIDIA GeForce 
GT 120

Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, v10.7.5 
and Mountain Lion 
v10.8, v10.8.1, 
v10.8.2

Software Only
Nitris DX
Mojo DX

Mac Pro “Nehalem” 
Dual 2.26 GHz Quad 
Core Intel

NVIDIA GeForce GT 
120

Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, v10.7.5 
and Mountain Lion 
v10.8, v10.8.1, 
v10.8.2

Software Only

Mac Pro “Harpertown” 
Dual Quad Core 3.0 or 
3.2 GHz

NVIDIA GeForce 
8800 GT

Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, v10.7.5 
and Mountain Lion 
v10.8, v10.8.1, 
v10.8.2

Software Only
Nitris DX
Mojo DX
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iMac 27” Display Quad 
Core 3.4 GHz

ATI 6970M Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, v10.7.5 
and Mountain Lion 
v10.8, v10.8.1, 
v10.8.2

Software Only

iMac 27” Display Quad 
Core 2.93 GHz

ATI 4850 Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, v10.7.5 
and Mountain Lion 
v10.8, v10.8.1, 
v10.8.2

Software Only

iMac 21.5” Display 
Dual Core 3.6GHz

GeForce 9400 Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, v10.7.5 
and Mountain Lion 
v10.8, v10.8.1, 
v10.8.2

Software Only

iMac 27” Display 
2.8 GHz 4 GB Quad 
Core 1066MHz

ATI Radeon HD 4850 
Graphics Processor

Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, v10.7.5 
and Mountain Lion 
v10.8, v10.8.1, 
v10.8.2

Software Only

iMac 27” Display Quad 
Core 2.8GHz

ATI 4850 Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, v10.7.5 
and Mountain Lion 
v10.8, v10.8.1, 
v10.8.2

Software Only

iMac 20” Display 
2.66 GHz Core 2 Duo

GeForce 9400 Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, v10.7.5 
and Mountain Lion 
v10.8, v10.8.1, 
v10.8.2

Software Only

Qualified Macintosh 
Hardware Graphics Cards Qualified OS Supported With
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Qualified Macintosh Notebooks for Media Composer and Avid Symphony

The following Macintosh notebooks are qualified with the current editing applications. The 
following applies to the editing system when running on a laptop.

• HD Capture on Macintosh notebooks is not supported

• Playback in full quality 10 bit mode is not supported

Qualified Macintosh 
Notebook Graphics Cards Qualified OS Supported With

MacBook Air 13” 
1.7GHz Dual-Core Intel Core i5 
or 
1.8GHz Dual-Core Intel Core i7

Intel 
3000

Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, v10.7.5 
and Mountain 
Lion v10.8, 
v10.8.1, v10.8.2

Software Only

MacBook Pro 17" 
2.2/2.3/ GHz Quad Core i7

6750M
Intel 
3000

Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, v10.7.5 
and Mountain 
Lion v10.8, 
v10.8.1, v10.8.2

Software Only

MacBook Pro 15" 
2.0/2.2/2.3GHz Quad Core i7

6490M
6750M
Intel 
3000

Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, v10.7.5 
and Mountain 
Lion v10.8, 
v10.8.1, v10.8.2

Software Only

MacBook Pro 15" 
2.53GHz Dual Core i5
15” or 17” 2.66GHz Dual Core i7

GT 330M Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, v10.7.5 
and Mountain 
Lion v10.8, 
v10.8.1, v10.8.2

Software Only
17” only - Mojo DX (no 
DNxHD capture)

MacBook Pro 15” or 17” 
2.53/2.66/2.8 GHz Core 2 Duo

 9400M and 9600M Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, v10.7.5 
and Mountain 
Lion v10.8, 
v10.8.1, v10.8.2

Software Only
Mojo DX (no DNxHD capture)
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Compatibility Chart

The following table lists the NVIDIA® driver, QuickTime®, Windows Media™, shared storage, 
Sony® XDCAM™, Panasonic® P2, and Pro Tools LE® versions that were qualified with the Avid 
editing applications. Also listed are the third-party applications such as Boris Continuum 
Complete, Avid DVD by Sonic™, and Sorenson Squeeze®. 

MacBook Pro 15” and 17” 
2.5 GHz Core 2 Duo

 8600M Lion v10.7.1, 
v10.7.2, v10.7.3, 
v10.7.4, v10.7.5 
and Mountain 
Lion v10.8, 
v10.8.1, v10.8.2

Software Only
Mojo DX (no DNxHD capture)

Qualified Macintosh 
Notebook Graphics Cards Qualified OS Supported With

Item Versions Comments

QuickTime Support v7.7.3 (Windows)
v10.x, (v7.x legacy) (Macintosh)

Note: QuickTime v10X does not include 
QuickTime Pro options.

Windows Media 
Version Support

Windows Media Player 12 (for 
Windows 7)

If you do not have Windows Media 
Player, access the download at 
www.microsoft.com.

Windows Media export compatibility is 
subject to Microsoft Windows Media 
updates.

Avid Interplay 
Support

See the Knowledge Base article 
“Interplay and Avid Editor 
Compatibility.”

IMPORTANT: The Avid Interplay 
components that get installed on the 
editing application must be updated to 
the Avid Interplay version that is released 
with the editing application. These 
include the Media Indexer, Interplay 
Access, Interplay Framework, Interplay 
Transfer Client and ProEncode Client. 
The Avid Interplay Server components 
can remain on the previous releases listed 
as supported. For details, see the “Avid 
Editing Application Compatibility with 
Interplay Releases” topic in the Avid 
Interplay ReadMe.

http://www.microsoft.com/en/us/default.aspx
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NVIDIA Driver 
Support

v275.89 See Setting up the NVIDIA Card.
For setting up the driver for stereoscopic, 
see the NVIDIA setup info in the 
Stereoscopic 3D Workflow Guide.

Shared Storage 
Support

Avid Unity™ MediaNetwork and 
Avid Unity ISIS®.

See “Shared Storage Support” on 
page 34.

Pro Tools • For information on supported 
versions of Pro Tools in an Interplay 
environment, see the Avid Interplay 
ReadMe or 
http://avid.custkb.com/avid/app/selfs
ervice/search.jsp?DocId=353977&Hi
lite=Pro+Tools+Interplay

• For Co-install information, see Avid 
Editing Application Compatibility 
with Pro Tools.

• For Video Satellite information, see 
the Video Satellite Guide or 
http://avid.custkb.com/avid/app/selfs
ervice/search.jsp?DocId=354337&Hi
lite=video+satellite

Sony XDCAM 
driver

v2.13 (XDCAM Transfer for 
Macintosh)

Win 7-64 FAM 2.3.2 and VFAM 
3.4.0

The VFAM firmware version is 2.45. The 
driver can be downloaded from Sony's 
website http://esupport.sony.com/.

Panasonic P2 drive (Macintosh) No device support 
for Lion

(Windows 7) Driver version for 
P2 devices:v2.16

There is currently no P2 writeback 
support for Macintosh clients.

Boris Continuum 
Complete

v8.1 Ships with:
Avid Symphony™ 

Avid DVD by Sonic v6.4.4 Ships with:
Avid Media Composer
Avid Symphony
Avid NewsCutter

Item Versions Comments

http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=353977&Hilite=Pro+Tools+Interplay
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=353977&Hilite=Pro+Tools+Interplay
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=353977&Hilite=Pro+Tools+Interplay
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=354337&Hilite=video+satellite
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=354337&Hilite=video+satellite
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=354337&Hilite=video+satellite
http://esupport.sony.com/
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Avid Editing Application Compatibility with 
Pro Tools

General Co-Installation Notes:

• Install Pro Tools first and then Media Composer.

• You must uninstall all older versions of Media Composer or Pro Tools before installing 
newer versions.

• Co-install does not support both applications launched simultaneously.

• When you uninstall Pro Tools, choose to uninstall just the application and not the audio 
drivers or the editing application no longer sees the devices. On a Macintosh Pro Tools 
system, this is named the “Safe Uninstall.” On a Windows Pro Tools system, you must select 
the first uninstall option — “Pro Tools Only” — which is not selected by default.

• (Macintosh only) When you uninstall your Avid editing application, you must uninstall just 
the application and not the audio drivers or Pro Tools no longer sees the devices. When you 
start the Avid Uninstaller, deselect the options to uninstall AvidCoreRuntime.pkg and 
AvidDIORuntime.pkg.

• Mojo SDI will not be supported with Media Composer, but can still be connected in a 
co-install configuration for use with Pro Tools.

• If you install and configure Avid Mojo DX or Nitris DX hardware on your system, the 
editing application does not use any connected Pro Tools audio device for audio input/output 
operations. You can also use these audio devices with a software-only version of your Avid 
editing application (Media Composer and NewsCutter).

Sorenson Squeeze v8.1 Ships with:
Avid Media Composer
Avid NewsCutter
Avid Symphony

Avid FX v6.0.6 (Windows)

v6.0.6 (Macintosh)

Ships with:
Avid Media Composer
Avid Symphony 
Avid NewsCutter

Avid Artist Series 
(Euphonix)

EuControl software v2.6.2 or later See the User’s Guide for information on 
Artist Series Color setup information.

Item Versions Comments
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• If you run into any issues, uninstall both applications and reinstall Pro Tools first, and then 
reinstall your editing application.

• Media Composer v5.0 and later and Pro Tools v8.0.3 and later do not include support for the 
Original Mbox. If you want to use the Original Mbox, you should use Media Composer v4.x 
and Pro Tools v8.0.1 instead.

• If you want to install your Avid editing application on a system with the Pro Tools Avid 
Video Engine installed, you must use one of the following configurations:

- Media Composer v5.5/NewsCutter v9.5 and later with Pro Tools v9.0 or later.

- Media Composer v5.0.x/NewsCutter v9.0.x with Pro Tools v8.5 or earlier.

Co-installation Configurations and Audio Device 
Support

Avid Pro Tools Applications

Avid Mbox Family Audio Devices (3rd Generation)

Pro Tools 
Product

MC/NC 
Software 
Only

MC/NC 
with Mojo 
DX

MC/NC/
Symphony 
with Nitris DX

Pro Tools 
Software Only

Co-install Co-install Co-install

Pro Tools|HD 
Native

Co-install/
Audio Device

Co-install Co-install

Pro Tools|HD Co-install/
Audio Device

Co-install Co-install

Pro Tools|HD, 
with chassis

Not Tested Not Tested Not Tested

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
Symphony 
with Nitris DX

Mbox 
(USB)

Co-install/
Audio Device

Co-install Co-install

Mbox Pro Co-install/
Audio Device

Co-install Co-install
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Avid Mbox 2 Family Audio Devices

Other Avid Audio Devices

Mbox Mini 
(USB)

Co-install/
Audio Device

Co-install Co-install

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
Symphony 
with Nitris DX

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
Symphony 
with Nitris DX

Mbox 2 
(USB)

Co-install/
Audio Device

Co-install Co-install

Mbox 2 Pro 
(1394)

Co-install Co-install Co-install

Mbox 2 
Mini (USB)

Co-install/
Audio Device

Co-install Co-install

Mbox 2 
Micro 
(USB)

Co-install Co-install Not tested

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
Symphony 
with Nitris DX

Digi 002 
(1394)

Co-install/
Audio Device 
(Windows)

Co-install Co-install

Digi 003 
(1394)

Co-install Co-install Co-install

Eleven Rack 
(USB)

Not Supported Not Supported Not Supported

Fast Track 
Pro (USB)

Audio Device Not Supported Not Supported
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External Controllers
Your Avid editing application supports the following external fader controllers or mixers for 
automation gain and pan recording or as control surfaces:

• Digi 002 (Windows only — Media Composer and NewsCutter)

• Command|8

• Avid Artist Control

• Avid Artist Mix

• Avid Artist Transport

• Avid Artist Color

• JL Cooper MCS-3000X MIDI automation controller

• JL Cooper FaderMaster Pro MIDI automation controller

• Yamaha® 01V/96 and Yamaha 01V digital mixing console

n The JL Cooper controllers and Yamaha mixing consoles do not support automation pan 
recording.

External controllers or mixers are optional. They are not required for you to perform automation 
gain or pan recording on an Avid editing system.

The following table compares Avid external controllers and mixers.

Feature
Digi 002 
(MC/NC only) Command|8

Avid Artist 
Control

Avid Artist 
Mix

Avid Artist 
Transport

Avid Artist 
Color

Control surface 
for transport 
controls and 
other functions

Yes Yes Yes Yes 
(transport 
only, no soft 
keys)

Yes

Provides audio 
play, input, and 
output

Yes No No No No

Record 
automation gain

Yes Yes Yes Yes No

Record 
automation pan

Yes Yes Yes Yes No

Flying faders Yes (8) Yes (8) Yes (4) Yes (8) No
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The following table compares supported third-party external controllers and mixers.

Touch-sensitive 
faders

Yes Yes Yes Yes No

Touch-sensitive 
panners

No No Yes Yes No

Solo/mute Yes Yes Yes Yes No

Supports audio 
mixing

Noa No No No No

Latch mode 
(also known as 
Snap mode)

Yes Yes Yes Yes No

Number of 
steps of fader 
accuracy

1024 1024 1024 1024 Not applicable

a. The Digi 002 can be used as a standalone audio mixer but not at the same time as it is being used as an automation gain or 
automation pan controller or control surface.

Feature
Digi 002 
(MC/NC only) Command|8

Avid Artist 
Control

Avid Artist 
Mix

Avid Artist 
Transport

Avid Artist 
Color

Feature FaderMaster Pro MCS-3000X Yamaha 01V/96 and Yamaha 01V

Control surface for transport 
controls and other functions

No No No

Provides audio play, input, and 
output

No No No

Record automation gain Yes Yes Yes

Record automation pan No No No

Flying faders No Yes Yes

Touch-sensitive faders No Yes No

Solo/mute Yes Yes Yesa

Supports audio mixing No No Yes

Latch mode (also known as 
Snap mode)

No Yes No
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For more information on using these external fader controllers or mixers, see “Recording 
Automation Gain or Automation Pan Information” in the Help.

Setting up the NVIDIA Card

To set up the NVIDIA card, you must make sure you have the correct display driver version 
(install the display driver if necessary, and set the correct display settings. This version of the 
editing application requires the following Nvidia Driver:v275.89 

Prior to setting up the NVIDIA card, check to make sure you have the correct display driver 
version. If you do not have the correct NVIDIA driver, you can install it from the Utilities folder 
that installs with your Avid application.
Installation files for these drivers are installed in the folder Program Files\Avid\Utilities\nVidia.

To check the NVIDIA display driver version:

1. Right-click the Desktop and select NVIDIA Control Panel. You can also open the Windows 
Control Panel and double-click the NVIDIA Control Panel icon.

2. Click System Information at the bottom left corner of the NVIDIA Control Panel.

The version number is listed in the Graphics card information section on the ForceWare 
version line.

To install the NVIDIA display driver:

1. Navigate to Program Files\Avid \ Utilities \nVidia and double-click the folder that 
corresponds to your operating system.

2. Double-click the file for the applicable driver.

3. Follow the on-screen instructions, and then restart your system.

To setup multiple displays:

1. Right-click the Desktop, and select Nvidia Control Panel. 

2. In the settings window in the left of the window, click Set up multiple displays.

3. Select or deselect the desired monitors listed.

Number of fader steps of 
accuracy

128 1024 256

a. For Yamaha fader/controllers, solo works only if you do not use the unit for audio mixing at the same time

Feature FaderMaster Pro MCS-3000X Yamaha 01V/96 and Yamaha 01V
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To set Desktop Video Editing Mode:

1. Right-click the Desktop, and select Nvidia Control Panel. 

2. In the menu bar, select Desktop. Enable Desktop>Video Editing Mode.

3. Click Apply.

To set the Prefer Maximum Performance mode and Global Settings:

1. Right-click the Desktop, and select Nvidia Control Panel.

2. Click Manage 3D Settings.

3. Set Global presets to Base profile.

4. In the Global Settings tab, change Power Management mode to Prefer Maximum 
Performance.

5. Click Apply.

6. Set the Global preset to 3D App-Video Editing.

7. Click Apply.

Reboot after installing the Nvidia software even if you are not prompted to do so. 
Never use the Windows “roll back driver” feature on the Nvidia driver. The driver version must 
match the rest of the components the Nvidia installer installs.

Shared Storage Support

The editing application has been tested in a shared storage environment with the following.

There is no support for ethernet attached clients in a MediaNetwork environment.

Editing 
Application 
Operating 
System

ISIS 
Clients

ISIS 
5000 
Server

ISIS 
2000 
Server

ISIS 
7000 
Server

Media-
Network 
Client

Media-
Network 
Server

Windows 7 64-bit  v4.0, 
v4.2

v3.2, 
v4.0, 
v4.0.1, 
v4.0.3

v4.1, v4.2  v2.4. v4.0, 
v4.0.1, v4.0.3

v5.4 v5.1.3

Macintosh Lion 
v10.7.3

 v.4.0, 
v4.2

v3.2, 
v4.0, 
v4.0.1, 
v4.0.3

v4.1, v4.2 v2.4., v4.0, 
v4.0.1, v4.0.3

v5.5.1 v5.1.3
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Feature Performance

A number of features in this editing application are processor-intensive. As a result, you might 
experience problems if you are working on an older system. The following chart shows the 
hardware that Avid has successfully qualified when using these features. 

Macintosh 
Mountain Lion 
v10.8.x

4.2 v3.2, 
v4.0, 
v4.0.1, 
v4.0.3

 v4.1, v4.2  v2.4., v4.0, 
v4.0.1, v4.0.3

not 
supported

 not 
supported

Editing 
Application 
Operating 
System

ISIS 
Clients

ISIS 
5000 
Server

ISIS 
2000 
Server

ISIS 
7000 
Server

Media-
Network 
Client

Media-
Network 
Server

Feature Description Recommended System

J2K Capture • HP z800 Dual Quad Core, or Dual 6 
Core, with Hyperthreading On

• Dell T5500 Dual 6 Core with 
Hyperthreading On 

• Mac Pro Dual 6 Core “Westmere”

Stereoscopic 3D For optimal performance with 
Stereoscopic 3D, use these higher 
performance systems. Avid 
recommends a minimum of 12GB 
RAM when using Stereoscopic 
3D.

• HP z800 Dual Quad Core, or Dual 6 
Core, with Hyperthreading On

• HP z400, 6-core with Hyperthreading 
On

• Dell T3500 Single 6 Core with 
Hyperthreading On

• Dell T5500 Dual, 2.93GHz Quad 
Core with Hyperthreading On 

• Mac Pro Dual 6 Core “Westmere”
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XDCAM HD50 Capture Baseband capture through Nitris 
DX, Mojo DX

• HP z800 Dual Quad Core, or Dual 6 
Core, with Hyperthreading On

• HP z400, 6-core with Hyperthreading 
On

• Dell T3500 Single 6 Core with 
Hyperthreading On

• Dell T5500 Dual, 2.93GHz Quad 
Core with Hyperthreading On 

• Mac Pro Dual Quad Core “Nahalem” 
or Dual 6 Core “Westmere”

HD RGB HD RGB capture requires a high 
end workstation with Nitris DX 
and fast storage. (The HP z800 
and the Dell T5500 have been 
qualified to successfully play 
back 2 streams with PIP and 
Color Correction effects. The Mac 
Pro Dual Quad Core “Nahalem” 
successfully plays back 2 streams 
with PIP.)

• HP z800 Dual Quad Core, or Dual 6 
Core, with Hyperthreading On

• HP z400, 6-core with Hyperthreading 
On

• Dell T3500 Single 6 Core with 
Hyperthreading On

• Dell T5500 Dual, 2.93GHz Quad 
Core with Hyperthreading On 

• Mac Pro Dual Quad Core “Nahalem” 
or Dual 6 Core “Westmere”

• Storage: 10Gb Ethernet ISIS, 

AMA (RED) AMA is a processor intensive 
operation. Older platforms may 
not offer optimum performance.

• HP z800 Dual Quad Core, or Dual 6 
Core, with Hyperthreading On

• HP z400, 6-core with Hyperthreading 
On

• Dell T3500 Single 6 Core with 
Hyperthreading On

• Dell T5500 Dual, 2.93GHz Quad 
Core with Hyperthreading On 

• Mac Pro Dual Quad Core “Nahalem” 
or Dual 6 Core “Westmere”

AMA (QuickTime) AMA is a processor intensive 
operation. Lower end platforms 
may not offer optimum 
performance. Highly compressed 
codecs such as H.264 will exhibit 
minimal real-time performance. 

Recommendation of qualified systems 
depends on your planned use of this 
feature. Heavy usage of highly 
compressed codecs requires the high end 
systems. 

Feature Description Recommended System
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Ancillary Data Ancillary Data and Nitris DX: 
Due to software DNxHD codec 
performance requirements, you 
must have a dual quad core 
system in order to capture 
DNxHD 220 or 220x with 
ancillary data on the Nitris DX 
platform. 

Dual Quad Core or dual 6-core Systems

DVCPro HD capture You will get better performance 
with a dual quad core or dual 
6-core system.

Dual Quad Core or dual 6-core Systems

Feature Description Recommended System
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AVCI-Intra AVC-Intra(AVC-I) is a high 
quality, low bit-rate HD codec and 
is very CPU intensive. 

4-Way MultiCam Playback

• HP z800 Dual Quad Core or Dual 6 
Core, with Hyperthreading On - 
64-bit OS

• Mac Pro Dual Quad Core “Nahalem” 
or Dual 6 Core “Westmere”

Four Stream Playback:

• HP z800 Dual 6 Core with 
Hyperthreading On - 64-bit OS

• Mac Pro Dual 6 Core “Westmere”

Two Stream Playback:

• HP z400, single 6 Core with 
Hyperthreading On

Single Stream Playback:

• Systems listed above.

• HP z400, single 4-core with 
Hyperthreading On

• HP 8600, dual 4-core without 
Hyperthreading On

• HP 8740w laptop, i7 (1.73GHz) 
4-core with Hyperthreading On 

• HP 8540w laptop, i7 (1.73GHz) 
4-core with Hyperthreading On 

• Dell Precision M6500 laptop, i7 (2.00 
GHz) 4-core with Hyperthreading On

• The MacBook Pro 17" laptop, i7 (2.66 
GHz) 2-core with Hyperthreading On

• iMac 27", i7 (2.8GHz) 4-core with 
Hyperthreading On

Feature Description Recommended System
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Limitations

The following limitations apply to the current version of the editing application.

Avid Artist Color

➤ Bug Number: UDevC00157064. Some soft keys do not light up when you use the Avid Artist 
Color with your Avid editing application, including the following:

• HSL Shift Layer: all soft keys

• HSL Bank 2 Shift Layer: all soft keys

• Curves: F8 and F9 soft keys

• Curves Shift: F1, F3, F6, and F9 soft keys

• Secondary: F2, F7, F8, and F9 soft keys

• Secondary Shift: all soft keys

The soft keys listed above function normally even when they do not light up.

➤ Bug Number: UDevC00163957. Hue offset color wheels might not appear when you use Artist 
Color to enter Color Correction mode the first time after start your Avid editing application. Any 
parameter update will draw them.

Workaround:  When you make any change in a parameter in the Color Correction tool, the 
color wheels appear.

➤ Bug Number: UDevC00156948.  (The F2 soft key (Next HSL Subtab) does not function until 
after you apply a color correction to your footage. If you press F2 (Next HSL Subtab) on the 
Artist Color surface before you apply a color correction, you get a system beep and the subtab 
does not change.

➤ Bug Number: UDevC00157932. If you use the HSL shift control for trackballs, you might see 
the trackballs controlling the wrong monitor during shuttle. For example, if you press Shift and 
then use the right trackball to shuttle, and then move either the left or the center trackball, you 
might see the other trackballs now control the right monitor. 

➤ Bug Number: UDevC00164772. When you first ope n the Color Correction tool, either with the 
Artist Color or with the mouse, incorrect color correction values might display in parameter 
fields. This problem is intermittent, and it does not occur after you change a parameter value.

Workaround:  Adjust any parameter. The correct values display in the Color Correction tool.
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➤ Bug Number: UDevC00164954. (Macintosh only): The EuControl application does not open 
when you select Edit Settings in the Controller Settings dialog box. To configure your EUCON 
device, you must open the EuControl application by clicking the EUCON icon in the dock, and 
then selecting Window > EuControl Settings.

Compatibility

➤ Bug Number: UDevC00166431. You might receive AMPI Subsystem errors when launching 
the editing application. Avid recommends that you refer to the following Knowledge Base article 
for information on possible causes.
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=377091

➤ Bug Number: UDevC00151588. You must have the MediaNetwork client installed on your 
system in order to play linked AMA clips from the MediaNetwork shared storage.

➤ Bug Number: . The Standalone Transfer Manager will be supported with this release, except for 
compatibility with Airspeed Classic and Open I/O devices.

Effects

➤ Bug Number: . AVX 1 effects are no longer supported and will not be recognized in this latest 
version of Media Composer. Please contact the respective 3rd-party plug-in vendor for an AVX2 
64-bit version of any existing plug-in that you might have purchased. The following Avid AVX1 
effects will automatically be promoted to AVX2:

• Avid Pan & Zoom

• Region Stabilize

• RGB Keyer

When you load a previously-generated sequence containing one of these effects, they will 
automatically be promoted to new corresponding AVX2 effects. These effects will not be 
recognized by earlier versions of Media Composer.

➤ Modifying Pan Values in the Timeline: You can display different pan values in the Timeline for 
different audio tracks by clicking the Clip Gain/Pan button in the Track Control panel and 
selecting one of the pan value options. However, if you want to manipulate pan control points 
(either adding a keyframe or adjusting a keyframe), you must make sure all audio tracks display 
the same pan values. To do this, Alt+click the Clip Gain/Pan button in the Track Control panel 
for any audio track and select a pan value option.

http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=377091
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Interplay

➤ Interplay v.2.5 support for native HD 23.976p and HD 24p formats now includes their associated 
proxy resolutions. For more information refer to the Avid Interplay Best Practices Guide.

➤ Bug Number: . (Interplay) Dynamic relink is not currently supported for media that requires 
pulldown. Therefore, you can only use it with clips where the media has been acquired at the 
native frame rate (without pulldown).

➤ Bug Number: . (Interplay) Pro Res formats can only be used by Avid editing applications that 
are in a non-Interplay environment. For any additional limitations regarding running an Avid 
editing application in an Interplay environment, see the Interplay ReadMe.

➤ Bug Number: UDevC00164931. (Avid Interplay and Windows 7) Can't locate Media Indexer 
on Avid editor after first install. After an initial installation of the editor and Interplay support 
software, the editing application may fail to locate the Media Indexer. This can happen if some of 
the Avid Service Framework services have not started correctly.

Workaround:  Open the Workgroup Properties tool on the editor and check whether any of the 
services are not running. Restart any services as required. Then restart the Avid editing 
application again. You may have to do this the first few times that you start the editor. After a few 
times the services will begin starting automatically, even after a reboot.

Media Tool

➤ Bug Number: UDevC00164836. If the Media Tool window is set to Frame view, you might 
experience slow redraw issues when accessing large volumes of shared storage.

Output

➤ You cannot control down/cross conversion from the Video Output Tool when in TrueP mode for 
1080p projects or when you are in Stereoscopic mode.

Workaround:  When in stereoscopic mode or have True Progressive output set for 1080p 
projects, the down-convert and cross-convert options are not available. To output at a rate 
different than the project format, go to the Format tab and change the output project setting.

PhraseFind

➤ Bug Number: UDevC00166649. For best results with PhraseFind, Avid recommends using 
Avid certified storage solution.



Limitations

42

Play

➤ Bug Number: UDevC00164987. After editing for an extended period of time, using the 
keyboard arrow keys to single step through the sequence might skip frames or move in the wrong 
direction. 

Workaround:   Minimize and maximize the editing application or change focus to another 
application and then back to the editor.

➤ Bug Number: UDevC00153838. You might receive an “Exception: The sequence or one of its 
source elements is too long to be played” error if you have a sequence over 12 hours.

QuickTime

➤ Bug Number: UDevC00159820. QuickTime Reference movies are not supported by 
QuickTime Player X. They are still supported in QuickTime Player 7 on the Macintosh. They are 
also not supported in QuickTime version 7.6.9 on Windows.

Stereoscopic 3D

➤ A software developer's kit is now available for 3rd-party partners who would like to build AMA 
plug-ins, AVX2 effects, or develop applications that support stereoscopic 3D media/sequences 
compatible with Avid Media Composer or Symphony. This developer's kit is available on the 
Avid website.

➤ 720p Stereoscopic projects are not currently supported with Open I/O hardware from 3rd-party 
vendors.

➤ Bug Number: UDevC00164741. If a rolling title is used in an Over\Under stereo project, you 
may get the wrong scaling and cropping of lines.

➤ Stereoscopic projects are not supported on Avid Interplay.

➤ Multicam of stereoscopic clips is not supported. 
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➤ NVIDIA 3D Vision

• Avid currently only supports the NVIDIA 3D Vision Home bundle (which includes the 3D 
glasses, emitter hub and display monitor). The 3D Vision Pro has not been successfully 
tested.

• Full screen playback on an NVIDIA 3D Vision monitor is only supported on a Windows 
system.

• Due to an NVIDIA driver issue, the first time that the full screen play window appears, the 
application will resize to a single monitor. Resize the application as necessary. You can reset 
your window positions by clicking on a toolset in the menu.

➤ Bug Number: UDevC00161499. Ancillary data output is not supported if you are working in 
full stereoscopic format.

Timeline

➤ Bug Number: UDevC00164751. If you have a sequence loaded in the Timeline, and you have 
waveforms on, clicking or dragging in the Timeline does not stop the waveform from drawing. 

Workaround:  Hold Cmd + . to stop the waveform from drawing. 

User Interface

➤ Bug Number: UDevC00162819. You cannot copy and paste timecode values into the Source or 
Record monitors. To enter timecode in the monitors, select the monitor and then type in the 
appropriate timecode values.

➤ Bug Number: UDevC00164678. You can drag audio keyframes past adjacent audio keyframes. 
Moving an audio keyframe past another keyframe causes the keyframes to swap values. For 
example, set volume levels on two audio keyframes: Keyframe A for low volume (left keyframe) 
and Keyframe B for high volume (right keyframe). If you then drag Keyframe A to the right of 
Keyframe B, Keyframe A now displays the higher volume level. 

➤ Bug Number: UDevC00164995. (Macintosh only) If you load a group clip into the Source 
monitor while in MultiCamera mode, the monitor displays the clip as if MultiCamera mode is 
still selected, although the action of loading the group clip actually causes the Avid editing 
application to enter Source/Record mode. If you play back the clip, you only see the linecut and 
cannot perform MultiCamera edits.

Workaround:  To turn off the Multicamera mode display, select Special > Multicamera Mode, 
and make sure MultiCamera Mode is not selected.
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➤ Bug Number: UDevC00165159. (Macintosh only) If you render a sequence containing a title 
by selecting Clip > Render In/Out or by right-clicking the sequence and selecting Render In/Out, 
the progress bar displaying the status of the render operation does not update and the application 
appears to become unresponsive. However, even though the progress bar does not advance, the 
rendering operation continues. When it completes, the progress bar closes.

Documentation Changes

The following documentation changes were made after the initial documentation release was 
finalized. These will be corrected in the next release of the product. 

Lassoing Segments in NewsCutter

When selecting a segment in the NewsCutter editing application Timeline, drawing a lasso from 
left to right selects the segment. If you have the Keyframe Selection tool enabled, drawing a 
lasso from left to right, selects the audio keyframes within the segment.

n Disable the Keyframe Selection Tool to enable selecting segments.

Committing Assets to an Export Volume

In the What’s New for v6.5, the topic “Committing Assets To an Export Volume” should have 
stated that once you commit the assets, the sequence is flattened to the OP1b format, the video is 
encoded to the codec set in the selected shim and audio saved as PCM. 
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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may 
only be used in accordance with the license agreement.

Avid products or portions thereof are protected by one or more of the following United States Patents: 5,077,604; 5,267,351; 
5,309,528; 5,355,450; 5,396,594; 5,440,348; 5,467,288; 5,513,375; 5,528,310; 5,557,423; 5,568,275; 5,577,190; 5,584,006; 
5,634,020; 5,640,601; 5,644,364; 5,654,737; 5,715,018; 5,719,570; 5,724,605; 5,726,717; 5,729,673; 5,745,637; 5,752,029; 
5,754,180; 5,754,851; 5,799,150; 5,812,216; 5,828,678; 5,842,014; 5,852,435; 5,905,841; 5,929,836; 5,930,445; 5,946,445; 
5,986,584; 5,987,501; 6,016,152; 6,018,337; 6,023,531; 6,058,236; 6,061,758; 6,091,778; 6,105,083; 6,118,444; 6,130,676; 
6,134,607; 6,141,691; 6,198,477; 6,201,531; 6,223,211; 6,249,280; 6,269,195; 6,330,369; 6,351,557; 6,353,862; 6,357,047; 
6,392,710; 6,404,435; 6,407,775; 6,417,891; 6,426,778; 6,477,271; 6,489,969; 6,512,522; 6,532,043; 6,546,190; 6,552,731; 
6,553,142; 6,570,624; 6,571,255; 6,583,824; 6,618,547; 6,636,869; 6,665,450; 6,678,461; 6,687,407; 6,704,445; 6,747,705; 
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